Welcome to the SparkFun Inventor’s Guide

The SparkFun Inventor’s Guide is your map for navigating the waters of beginning embedded electronics. This booklet contains all the information you will need to explore the 15 circuits of the SparkFun Inventor’s Kit for Educators. At the center of this manual is one core philosophy - that anyone can (and should) play around with electronics. When you’re done with this guide, you’ll have the know-how to start creating your own projects and experiments. Now enough talking - let’s get inventing!

www.sparkfun.com
### Section 1: Getting Started

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is the RedBoard platform?</td>
<td>1</td>
</tr>
<tr>
<td>Download Arduino Software (IDE)</td>
<td>3</td>
</tr>
<tr>
<td>Install Drivers</td>
<td>4</td>
</tr>
<tr>
<td>Identify Your Hardware</td>
<td>7</td>
</tr>
<tr>
<td>Download “SIK Guide Code”</td>
<td>8</td>
</tr>
</tbody>
</table>

### Section 2: Getting Started with Circuits

<table>
<thead>
<tr>
<th>Circuit</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The World Runs on Circuits</td>
<td>9</td>
</tr>
<tr>
<td>Inventory of Parts</td>
<td>11</td>
</tr>
<tr>
<td>RedBoard</td>
<td>13</td>
</tr>
<tr>
<td>Breadboard</td>
<td>15</td>
</tr>
<tr>
<td>Circuit #1 - Your First Circuit: Blinking a LED</td>
<td>17</td>
</tr>
<tr>
<td>Circuit #2 - Potentiometer</td>
<td>24</td>
</tr>
<tr>
<td>Circuit #3 - RGB LED</td>
<td>28</td>
</tr>
<tr>
<td>Circuit #4 - Multiple LEDs</td>
<td>32</td>
</tr>
<tr>
<td>Circuit #5 - Push Buttons</td>
<td>36</td>
</tr>
<tr>
<td>Circuit #6 - Photo Resistor</td>
<td>40</td>
</tr>
<tr>
<td>Circuit #7 - Temperature Sensor</td>
<td>44</td>
</tr>
<tr>
<td>Circuit #8 - A Single Servo</td>
<td>48</td>
</tr>
<tr>
<td>Circuit #9 - Flex Sensor</td>
<td>52</td>
</tr>
<tr>
<td>Circuit #10 - Soft Potentiometer</td>
<td>56</td>
</tr>
<tr>
<td>Circuit #11 - Piezo Element</td>
<td>60</td>
</tr>
<tr>
<td>Circuit #12 - Spinning a Motor</td>
<td>64</td>
</tr>
<tr>
<td>Circuit #13 - Relay</td>
<td>68</td>
</tr>
<tr>
<td>Circuit #14 - Shift Register</td>
<td>72</td>
</tr>
<tr>
<td>Circuit #15 - LCD</td>
<td>76</td>
</tr>
</tbody>
</table>
We live in a unique time where we have access to resources that allow us to create our own solutions and inventions. The DIY revolution is composed of hobbyists, tinkerers and inventors who would rather craft their own projects than let someone do it for them.

www.sparkfun.com

A Computer for the Physical World

The RedBoard in your hand (or on your desk) is your development platform. At its roots, the RedBoard is essentially a small portable computer. It is capable of taking inputs (such as the push of a button or a reading from a light sensor) and interpreting that information to control various outputs (like a blinking LED light or an electric motor).

That’s where the term “physical computing” is born - this board is capable of taking the world of electronics and relating it to the physical world in a real and tangible way. Trust us - this will all make more sense soon.

// SparkFun RedBoard

The SparkFun RedBoard is one of a multitude of development boards based on the ATmega328. It has 14 digital input/output pins (6 of which can be PWM outputs), 6 analog inputs, a 16 MHz crystal oscillator, a USB connection, a power jack, an ISP header, and a reset button. Don’t worry, you’ll learn about all these later.
- Power-Lacing High Tops
- Old Toy Email Notifier
- Bug Zapper Counter
- Auto-Plant Watering
- Camera Time-lapse operation
- Re-Programmed Traffic Light
- Auto-Coffee Maker
- Quadcopter
In order to get your RedBoard up and running, you'll need to download the newest version of the Arduino software first from www.arduino.cc (it’s free!). This software, known as the Arduino IDE, will allow you to program the board to do exactly what you want. It’s like a word processor for writing programs. With an internet-capable computer, open up your favorite browser and type in the following URL into the address bar:

[access the Internet]

Download the Arduino IDE (Integrated Development Environment)

Choose the appropriate Operating System installation package for your computer.
// Connect your RedBoard to your Computer

Use the USB cable provided in the SIK kit to connect the RedBoard to one of your computer’s USB inputs.

// Install Arduino Drivers

Depending on your computer’s operating system, you will need to follow specific instructions. Please go to https://learn.sparkfun.com/tutorials/how-to-install-ftdi-drivers for specific instructions on how to install the FTDI drivers onto your RedBoard.
Open the Arduino IDE software on your computer. Poke around and get to know the interface. We aren’t going to code right away, this is just an introduction. This step is to set your IDE to identify your RedBoard.
### GUI (Graphical User Interface)

1. **Verify**: Compiles and approves your code. It will catch errors in syntax (like missing semi-colons or parenthesis). // See Diagram Below
2. **Upload**: Sends your code to the RedBoard. When you click it, you should see the lights on your board blink rapidly. // See Diagram Below
3. **New**: This button opens up a new code window tab.
4. **Open**: This button will let you open up an existing sketch. // See Diagram Below
5. **Save**: This saves the currently active sketch.
6. **Serial Monitor**: This will open a window that displays any serial information your RedBoard is transmitting. It is very useful for debugging.
7. **Sketch Name**: This shows the name of the sketch you are currently working on.
8. **Code Area**: This is the area where you compose the code for your sketch.
9. **Message Area**: This is where the IDE tells you if there were any errors in your code.

// The three most important commands for this guide are seen below:

![Open]

![Verify]

![Upload]
// Select your board: Arduino Uno

Note:
Your SparkFun RedBoard and the Arduino UNO are interchangeable but you won’t find the RedBoard listed in the Arduino Software. Select “Arduino UNO” instead.

Select the serial device of the RedBoard from the Tools > Serial Port menu. This is likely to be com3 or higher (COM1 and COM2 are usually reserved for hardware serial ports). To find out, you can disconnect your RedBoard and re-open the menu; the entry that disappears should be the RedBoard. Reconnect the board and select that serial port.

Select the serial device of the RedBoard from the Tools > Serial Port menu. On the Mac, this should be something with /dev/tty.usbmodem or /dev/tty.usbserial in it.

http://www.arduino.cc/playground/Learning/Linux
Type in the following URL to download the code:

sparkfun.com/sikcode

Unzip the file “SIK Guide Code”. It should be located in your browser’s “Downloads” folder. Right click the zipped folder and choose “unzip”.

Copy the “SIK Guide Code” folder into Arduino’s folder named “examples”.

Unzip the file “SIK Guide Code”. It should be located in your browser’s “Downloads” folder. Right click the zipped folder and choose “unzip”.

Find “Arduino” in your applications folder. Right click (ctrl + click) on “Arduino”. Select “Show Package Contents”.

Copy the “SIK Guide Code” folder into Arduino’s folder named “examples”.

http://www.arduino.cc/playground/Learning/Linux

WHAT’S NEXT? Read on to learn more about getting started with circuits. Then you can start on your first circuit on page 17!
What is an Electrical Circuit?

A circuit is basically an electrical loop with a starting point and an ending point - with any number of components in between. Circuits can include resistors, diodes, inductors, sensors of all sizes and shapes, motors, and any other handful of hundreds of thousands of components.

Circuits are usually divided into three categories - analog circuits, digital circuits, or mixed-signal circuits. In this guide, you will explore all three sets of circuits.

The World Runs on Circuits:

Everywhere you look, you’ll find circuits. The cell phone in your pocket, the computer that controls your car’s emissions system, your video game console - all these things are chock full of circuits. In this guide, you’ll experiment with some simple circuits and learn the gist of the world of embedded electronics.

// Simple and Complex Circuits

In this guide, you will be primarily exploring simple circuits - but that doesn’t mean you can’t do amazing things with simple tools! When you’ve finished the SIK, your knowledge of circuits will enable you to explore amazing projects and unleash the power of your imagination.
Inventory of Parts

- **Jumper Wire**
  - Various Colors
  - Quantity: x30

- **LED (5mm)**
  - (Light Emitting Diode)
  - Quantity: x10, x10, x1

- **330Ω Resistor**
  - Quantity: x25

- **10KΩ Resistor**
  - Quantity: x25

- **Potentiometer**
  - Quantity: x1

- **Diode**
  - (1N4148)
  - Quantity: x2

- **Photo Resistor**
  - Quantity: x1

- **Piezo Element**
  - Quantity: x1

- **Temp. Sensor**
  - (TMP36)
  - Quantity: x1

- **Transistor**
  - (P2N2222AG)
  - Quantity: x2

- **DC Motor**
  - Quantity: x1

- **Push Button**
  - Quantity: x2
**Flex Sensor**

**Soft Potentiometer**

**Servo**

**Relay**

**Integrated Circuit (IC)**

**SparkFun RedBoard**

**Breadboard**

Standard Solderless (Color may vary)
SparkFun RedBoard

1. **Power In (Barrel Jack)** - Can be used with either a 9V or 12V wall-wart or battery.

2. **Power In (USB Port)** - Provides power and communicates with your board when plugged into your computer via USB.

3. **LED (RX: Receiving)** - This shows when the FTDI chip is receiving data bits from the microcontroller. This happens when the microcontroller is sending data bits back to the computer.

4. **LED (TX: Transmitting)** - This shows when the FTDI chip is transmitting data bits to the microcontroller. This happens when the microcontroller is receiving this data from the computer.

5. **LED (Pin 13: Troubleshooting)** - This LED is incorporated into your sketch to show if your program is running properly.

6. **Pins (ARef, Ground, Digital, Rx, Tx)** - These various pins can be used for inputs, outputs, power, and ground. // See Diagram Below

7. **LED (Indicates RedBoard is ON)** - This is a simple power indicator LED.

8. **Reset Button** - This is a way to manually reset your RedBoard, which makes your code restart.

9. **ICSP Pins (Uploading Code without Bootloader)** - This is for "In-Circuit Serial Programming," used if you want to bypass the bootloader.

10. **Pins (Analog In, Power In, Ground, Power Out, Reset)** - These various pins can be used for inputs, outputs, power, and ground. // See Diagram

11. **RFU** - This pin is reserved for future use.

---

The header pins are one of the most important parts for putting our example circuits together. Take a moment and locate the input/output ports of your RedBoard.
This line divides the board in half, restricting electricity to one half or the other.
How’s it all connected?

**Power:**
Each + sign runs power anywhere in the vertical column.

---

**Ground:**
Each - sign runs to ground anywhere in the vertical column.

---

**Horizontal Rows:**
Each of these rows numbered 1-30 are comprised of five horizontal sockets. Components placed in the same row will be connected in a circuit when power is running.

---

**Making a Connection:**
- Above the breadboard
- Inside the breadboard

---

View of the inside >>>
How It Works:

1. **ASSEMBLE**
   - Peel sticker off back of breadboard and stick into place.
   - Make sure the text on the RedBoard and breadboard are facing up so you can read them.
   - Screw the RedBoard down and into place.

2. **WRITE**

3. **UPLOAD**
   - Connect the USB cable.

Your RedBoard runs on 5V. This is the power that will be supplied from your computer via USB and will be the driving force behind any components you use in your circuits. By plugging your RedBoard into your computer, you are supplying it with just the right voltage it needs to thrive! 5V can’t hurt you, so don’t be afraid to touch anything in your circuit. You can also power the RedBoard through the barrel jack. The on-board voltage regulator can handle anything from 7 to 15VDC.
Blinking an LED

LEDs (light-emitting diodes) are small, powerful lights that are used in many different applications. To start off the SIK, we will work on blinking an LED. That’s right - it’s as simple as turning a light on and off. It might not seem like much, but establishing this important baseline will give you a solid foundation as we work toward more complex experiments.

This is a schematic of your circuit.

Parts:
- LED
- 330Ω Resistor
- Wire

This section lists the parts you will need to complete the circuit.

This is an illustration of how the completed circuit should look. It is not necessary to use the black holder for the RedBoard and breadboard, but we recommend it for the first time inventor!

Components like resistors need to have their legs bent into 90° angles in order to correctly fit the breadboard sockets. You can also cut the legs shorter to make them easier to work with on the breadboard.
Circuit 1: Blinking an LED

LED: Make sure the short leg, marked with flat side, goes into the negative position (-).

+ 330Ω Resistor: The color banding should read orange-orange-brown-gold. The component legs can go in either hole.

Jumper Wire: All jumper wires work the same. They are used to connect two points together. This guide will show the wires with different combinations of colors to make it clear which wires are the same. Different combinations of colors are completely acceptable.

Flat Edge Short Leg

LED:

Make sure the short leg, marked with flat side, goes into the negative position (-).
<table>
<thead>
<tr>
<th>Component:</th>
<th>Image Reference:</th>
</tr>
</thead>
<tbody>
<tr>
<td>LED (5mm)</td>
<td>![LED Image]</td>
</tr>
<tr>
<td>330Ω Resistor</td>
<td>![Resistor Image]</td>
</tr>
<tr>
<td>Jumper Wire</td>
<td>![Jumper Wire Image]</td>
</tr>
<tr>
<td>Jumper Wire</td>
<td>![Jumper Wire Image]</td>
</tr>
</tbody>
</table>

- **Components like LEDs are inserted into the breadboard sockets c2 (long leg) c3 (short leg). Steps highlighted with a yellow warning triangle represent a polarized component. Pay special attention to the component’s markings indicating how to place it on the breadboard.**

- **Resistors are placed in breadboard sockets only. The ‘-’ symbol represents any socket in its vertical column on the Power bus.**

- **“GND” on the RedBoard should be connected to the row marked ‘-’ on the breadboard.**

- **“5V” on the RedBoard connects to the row marked ‘+’ on the breadboard.**

- **“Pin 13” on the RedBoard connects to socket “e2” on the breadboard.**

- **RedBoard:** The red background represents a connection to one of the RedBoard header pins.

- **Breadboard:** The white background represents a connection to a breadboard socket specified by a letter-number coordinate such as e2. These coordinates are merely suggestions that align with the graphic image.
Open Up the Arduino IDE software on your computer. Coding in the Arduino language will control your circuit. Open the code for Circuit 1 by accessing the “SIK Guide Code” you downloaded and placed into your “Examples” folder earlier.

---

Open Your First Sketch:

Open Up the Arduino IDE software on your computer. Coding in the Arduino language will control your circuit. Open the code for Circuit 1 by accessing the “SIK Guide Code” you downloaded and placed into your “Examples” folder earlier.

---

// Circuit #1

```cpp
// Circuit #1

/*
Blink

Turns on an LED on for one second, then off for one second, repeatedly.

This example code is in the public domain.
*/

void setup() {
  // initialize the digital pin as an output.
  // Pin 13 has an LED connected on most Arduino boards:
pinMode(13, OUTPUT);
}

void loop() {
  digitalWrite(13, HIGH);   // set the LED on
  delay(1000);              // wait for a second
  digitalWrite(13, LOW);    // set the LED off
  delay(1000);              // wait for a second
}
```

---
// The result of a completed circuit with correct code after verified and uploaded.
### Open Arduino IDE // File > Examples > SIK Guide > Circuit # 1

**Troubleshooting:**

**LED Not Lighting Up?**
LEDs will only work in one direction. Try taking it out and twisting it 180 degrees (no need to worry, installing it backward does no permanent harm).

**Program Not Uploading**
This happens sometimes, the most likely cause is a confused serial port, you can change this in tools>serial port>

**Still No Success?**
A broken circuit is no fun, send us an e-mail and we will get back to you as soon as we can: techsupport@sparkfun.com

**Real World Application:**

Almost all modern flat screen televisions and monitors have LED indicator lights to show they are on or off.

---

**Arduino Code:**

```cpp
pinMode(13, OUTPUT);

digitalWrite(13, HIGH);
```

**What you Should See:**

You should see your LED blink on and off. If it isn’t, make sure you have assembled the circuit correctly and verified and uploaded the code to your board or see the troubleshooting tips below.

---

**Begin to understand how the Arduino code works. See below.**

- Before you can use one of the RedBoard’s pins, you need to tell the RedBoard whether it is an INPUT or OUTPUT. We use a built-in “function” called pinMode() to do this.
- When you’re using a pin as an OUTPUT, you can command it to be HIGH (output 5 volts), or LOW (output 0 volts).

---

**This is a section dedicated to the most common mistakes made while assembling the circuit.**

**Real World Application:**

Almost all modern flat screen televisions and monitors have LED indicator lights to show they are on or off.
In this circuit you’ll work with a potentiometer. A potentiometer is also known as a variable resistor. When it’s connected with 5 volts across its two outer pins, the middle pin outputs a voltage between 0 and 5, depending on the position of the knob on the potentiometer. A potentiometer is a perfect demonstration of a variable voltage divider circuit. The voltage is divided proportionate to the resistance between the middle pin and the ground pin. In this circuit, you’ll learn how to use a potentiometer to control the brightness of an LED.
Circuit 2: Potentiometer
If you look closely at your RedBoard, you’ll see some pins labeled "DIGITAL", and some labeled "ANALOG". What’s the difference?

Many of the devices you’ll interface to, such as LEDs and pushbuttons, have only two possible states: on and off, or as they’re known to the RedBoard, "HIGH" (5 volts) and "LOW" (0 volts). The digital pins on an RedBoard are great at getting these signals to and from the outside world, and can even do tricks like simulated dimming (by blinking on and off really fast), and serial communications (transferring data to another device by encoding it as patterns of HIGH and LOW).

But there are also a lot of things out there that aren’t just "on" or "off". Temperature levels, control knobs, etc. all have a continuous range of values between HIGH and LOW. For these situations, the RedBoard offers six analog inputs that translate an input voltage into a number that ranges from 0 (0 volts) to 1023 (5 volts). The analog pins are perfect for measuring all those "real world" values, and allow you to interface the RedBoard to all kinds of things.
A "variable" is a stored value you’ve given a name to. You must introduce, or “declare” variables before you use them; here we’re declaring a variable called `sensorValue`, of type "int" (integer). Don’t forget that variable names are case-sensitive!

```c
int sensorValue;
```

We use the `analogRead()` function to read the value on an analog pin. `analogRead()` takes one parameter, the analog pin you want to use ("sensorPin"), and returns a number ("sensorValue") between 0 (0 volts) and 1023 (5 volts).

```c
sensorValue = analogRead(sensorPin);
```

The Arduino is very very fast, capable of running thousands of lines of code each second. To slow it down so that we can see what it’s doing, we’ll often insert delays into the code. `delay()` counts in milliseconds; there are 1000 ms in one second.

```c
delay(sensorValue);
```

You should see the LED blink faster or slower in accordance with your potentiometer. If it isn’t working, make sure you have assembled the circuit correctly and verified and uploaded the code to your board or see the troubleshooting tips below.

**Troubleshooting:**

**Sporadically Working**
This is most likely due to a slightly dodgy connection with the potentiometer’s pins. This can usually be conquered by holding the potentiometer down.

**Not Working**
Make sure you haven’t accidentally connected the wiper, the resistive element in the potentiometer, to digital pin 0 rather than analog pin 0. (the row of pins beneath the power pins).

**LED Not Lighting Up?**
LEDs will only work in one direction. Try taking it out and twisting it 180 degrees (no need to worry, installing it backward does no permanent harm).

**Real World Application:**

Most traditional volume knobs employ a potentiometer.
You know what’s even more fun than a blinking LED? Changing colors with one LED. RGB, or red-green-blue, LEDs have three different color-emitting diodes that can be combined to create all sorts of colors. In this circuit, you’ll learn how to use an RGB LED to create unique color combinations. Depending on how bright each diode is, nearly any color is possible!
Circuit 3: RGB LED

* The longest lead is the common (gnd).
**Component:**

<table>
<thead>
<tr>
<th>Component</th>
<th>Image Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>RGB LED (5mm)</td>
<td>![RGB LED Image]</td>
</tr>
<tr>
<td>330Ω Resistor</td>
<td>![Resistor Image]</td>
</tr>
<tr>
<td>330Ω Resistor</td>
<td>![Resistor Image]</td>
</tr>
<tr>
<td>330Ω Resistor</td>
<td>![Resistor Image]</td>
</tr>
<tr>
<td>Jumper Wire</td>
<td>![Jumper Wire Image]</td>
</tr>
<tr>
<td>Jumper Wire</td>
<td>![Jumper Wire Image]</td>
</tr>
<tr>
<td>Jumper Wire</td>
<td>![Jumper Wire Image]</td>
</tr>
<tr>
<td>Jumper Wire</td>
<td>![Jumper Wire Image]</td>
</tr>
<tr>
<td>Jumper Wire</td>
<td>![Jumper Wire Image]</td>
</tr>
</tbody>
</table>

**The shocking truth behind analogWrite():**

We've seen that the Arduino can read analog voltages (voltages between 0 and 5 volts) using the `analogRead()` function. Is there a way for the RedBoard to output analog voltages as well?

The answer is no... and yes. The RedBoard does not have a true analog voltage output. But, because the RedBoard is so fast, it can fake it using something called PWM ("Pulse-Width Modulation"). The pins on the RedBoard with "~" next to them are PWM/Analog out compatible.

The RedBoard is so fast that it can blink a pin on and off almost 1000 times per second. PWM goes one step further by varying the amount of time that the blinking pin spends HIGH vs. the time it spends LOW. If it spends most of its time HIGH, a LED connected to that pin will appear bright. If it spends most of its time LOW, the LED will look dim. Because the pin is blinking much faster than your eye can detect, the RedBoard creates the illusion of a "true" analog output.

![PWM Diagram]

- **LOW (0 volts)**
  - 10%
  - 0.5V
- **HIGH (5 volts)**
  - 90%
  - 2.5V
- **LOW (0 volts)**
  - 50%
  - 4.5V
- **HIGH (5 volts)**
  - 10%
  - 90%
Many electronics such as videogame consoles use RGB LEDs to have the versatility to show different colors in the same area. Often times the different colors represent different states of working condition.

Arduino Code:

Open Arduino IDE // File > Examples > SIK Guide > Circuit # 3

Code to Note:

for (x = 0; x < 768; x++)
{}

A for() loop is used to step a number across a range, and repeatedly runs code within the brackets {}. Here the variable “x” starts a 0, ends at 767, and increases by one each time (“x++”).

if (x <= 255)
{}
else
{}

“If / else” statements are used to make choices in your programs. The statement within the parenthesis () is evaluated; if it’s true, the code within the first brackets {} will run. If it’s not true, the code within the second brackets {} will run.

delay(sensorValue);

The RedBoard is very very fast, capable of running thousands of lines of code each second. To slow it down so that we can see what it’s doing, we’ll often insert delays into the code. delay() counts in milliseconds; there are 1000 ms in one second.

What you Should See:

You should see your LED turn on, but this time in new, crazy colors! If it isn’t, make sure you have assembled the circuit correctly and verified and uploaded the code to your board or see the troubleshooting tips below.

Troubleshooting:

LED Remains Dark or Shows Incorrect Color
With the four pins of the LED so close together, it’s sometimes easy to misplace one. Double check each pin is where it should be.

Seeing Red
The red diode within the RGB LED may be a bit brighter than the other two. To make your colors more balanced, use a higher Ohm resistor. Or adjust in code.

analogWrite(RED_PIN, redIntensity);

to
analogWrite(RED_PIN, redIntensity/3);

Real World Application:

Many electronics such as videogame consoles use RGB LEDs to have the versatility to show different colors in the same area. Often times the different colors represent different states of working condition.
So you have gotten one LED to blink on and off – fantastic! Now it’s time to up the stakes a little bit – by connecting EIGHT LEDs AT ONCE. We’ll also give our RedBoard a little test by creating various lighting sequences. This circuit is a great setup to start practicing writing your own programs and getting a feel for the way RedBoard works.

Along with controlling the LEDs, you’ll learn about a couple programming tricks that keep your code neat and tidy:

- for() loops - used when you want to run a piece of code several times
- arrays[] - used to make managing variables easier by grouping them together
Circuit 4: Multiple LEDs
<table>
<thead>
<tr>
<th>Pin 2</th>
<th>Pin 3</th>
<th>Pin 4</th>
<th>Pin 5</th>
<th>Pin 6</th>
<th>Pin 7</th>
<th>Pin 8</th>
<th>Pin 9</th>
<th>5V</th>
<th>GND</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Resistor](330Ω Resistor.png)</td>
<td>![Resistor](330Ω Resistor.png)</td>
<td>![Resistor](330Ω Resistor.png)</td>
<td>![Resistor](330Ω Resistor.png)</td>
<td>![Resistor](330Ω Resistor.png)</td>
<td>![Resistor](330Ω Resistor.png)</td>
<td>![Resistor](330Ω Resistor.png)</td>
<td>![Resistor](330Ω Resistor.png)</td>
<td>![Resistor](330Ω Resistor.png)</td>
<td>![Resistor](330Ω Resistor.png)</td>
</tr>
</tbody>
</table>

**Component:**
- 330Ω Resistor
- 330Ω Resistor
- Jumper Wire
- Jumper Wire
- Jumper Wire
- Jumper Wire
- Jumper Wire
- Jumper Wire
- Jumper Wire
- Jumper Wire

**LED (5mm):**
- [LED (5mm)](LED (5mm).png)
- [LED (5mm)](LED (5mm).png)
- [LED (5mm)](LED (5mm).png)
- [LED (5mm)](LED (5mm).png)
- [LED (5mm)](LED (5mm).png)
- [LED (5mm)](LED (5mm).png)
- [LED (5mm)](LED (5mm).png)
- [LED (5mm)](LED (5mm).png)
- [LED (5mm)](LED (5mm).png)
- [LED (5mm)](LED (5mm).png)
Circuit 2

Arduino Code:

```cpp
int ledPins[] = {2,3,4,5,6,7,8,9};
digitalWrite(ledPins[0], HIGH);
index = random(8);
```

Code to Note:

- When you have to manage a lot of variables, an "array" is a handy way to group them together. Here we’re creating an array of integers, called `ledPins`, with eight elements.
- You refer to the elements in an array by their position. The first element is at position 0, the second is at position 1, etc. You refer to an element using "`ledPins[x]`" where x is the position. Here we’re making digital pin 2 HIGH, since the array element at position 0 is "2".
- Computers like to do the same things each time they run. But sometimes you want to do things randomly, such as simulating the roll of a dice. The `random()` function is a great way to do this. See [http://arduino.cc/en/reference/random](http://arduino.cc/en/reference/random) for more information.

What you Should See:

This is similar to circuit number one, but instead of one LED, you should see all the LEDs blink. If they aren’t, make sure you have assembled the circuit correctly and verified and uploaded the code to your board or see the troubleshooting tips below.

Troubleshooting:

- **Some LEDs Fail to Light**
  It is easy to insert an LED backwards. Check the LEDs that aren’t working and ensure they the right way around.

- **Operating out of sequence**
  With eight wires it’s easy to cross a couple. Double check that the first LED is plugged into pin 2 and each pin there after.

- **Starting Afresh**
  It’s easy to accidentally misplace a wire without noticing. Pulling everything out and starting with a fresh slate is often easier than trying to track down the problem.

Real World Application:

- Scrolling marquee displays are generally used to spread short segments of important information. They are built out of many LEDs.
Up until now, we’ve focused solely on outputs. Now we’re going to go to the other end of spectrum and play around with inputs. In this circuit, we’ll be looking at one of the most common and simple inputs – a push button. The way a push button works with RedBoard is that when the button is pushed, the voltage goes LOW. The RedBoard reads this and reacts accordingly. In this circuit, you will also use a pull-up resistor, which keeps the voltage HIGH when you’re not pressing the button.
One of the things that makes the RedBoard so useful is that it can make complex decisions based on the input it's getting. For example, you could make a thermostat that turns on a heater if it gets too cold, a fan if it gets too hot, waters your plants if they get too dry, etc.

In order to make such decisions, the Arduino environment provides a set of logic operations that let you build complex "if" statements. They include:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>==</td>
<td>EQUIVALENCE</td>
<td>A == B is true if A and B are the SAME.</td>
</tr>
<tr>
<td>!=</td>
<td>DIFFERENCE</td>
<td>A != B is true if A and B are NOT THE SAME.</td>
</tr>
<tr>
<td>&amp;&amp;</td>
<td>AND</td>
<td>A &amp;&amp; B is true if BOTH A and B are TRUE.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>!</td>
<td>NOT</td>
<td>!A is TRUE if A is FALSE. !A is FALSE if A is TRUE.</td>
</tr>
</tbody>
</table>

You can combine these functions to build complex if() statements.

For example:

```c
if ((mode == heat) && ((temperature < threshold) || (override == true))) {
  digitalWrite(HEATER, HIGH);
}
```

...will turn on a heater if you're in heating mode AND the temperature is low, OR if you turn on a manual override. Using these logic operators, you can program your RedBoard to make intelligent decisions and take control of the world around it!
The buttons we used here are similar to the buttons in most video game controllers.

**Troubleshooting:**

**Light Not Turning On**
The pushbutton is square, and because of this it is easy to put it in the wrong way. Give it a 90 degree twist and see if it starts working.

**Underwhelmed**
No worries, these circuits are all super stripped down to make playing with the components easy, but once you throw them together the sky is the limit.

**Real World Application:**
The buttons we used here are similar to the buttons in most video game controllers.

### Arduino Code:

**Open Arduino IDE // File > Examples > SIK Guide > Circuit # 5**

```
pinMode(button2Pin, INPUT);

button1State = digitalRead(button1Pin);

if (button1State == LOW)
```

The digital pins can be used as inputs as well as outputs. Before you do either, you need to tell the RedBoard which direction you’re going.

To read a digital input, you use the `digitalRead()` function. It will return HIGH if there’s 5V present at the pin, or LOW if there’s 0V present at the pin.

Because we’ve connected the button to GND, it will read LOW when it’s being pressed. Here we’re using the "equivalence" operator ("==") to see if the button is being pressed.

You should see the LED turn on if you press either button, and off if you press both buttons. (See the code to find out why!) If it isn’t working, make sure you have assembled the circuit correctly and verified and uploaded the code to your board or see the troubleshooting tips below.

What You Should See:

You should see the LED turn on if you press either button, and off if you press both buttons. (See the code to find out why!) If it isn’t working, make sure you have assembled the circuit correctly and verified and uploaded the code to your board or see the troubleshooting tips below.
So you’ve already played with a potentiometer, which varies resistance based on the twisting of a knob. In this circuit, you’ll be using a photo resistor, which changes resistance based on how much light the sensor receives. Since the RedBoard can’t directly interpret resistance (rather, it reads voltage), we use a voltage divider to use our photo resistor. This voltage divider will output a high voltage when it is getting a lot of light and a low voltage when it is not.
Circuit 6: Photo Resistor
Many of the sensors you’ll use (potentiometers, photoresistors, etc.) are resistors in disguise. Their resistance changes in proportion to whatever they’re sensing (light level, temperature, sound, etc.).

The RedBoard’s analog input pins measure voltage, not resistance. But we can easily use resistive sensors with the RedBoard by including them as part of a “voltage divider”.

A voltage divider consists of two resistors. The “top” resistor is the sensor you’ll be using. The “bottom” one is a normal, fixed resistor. When you connect the top resistor to 5 volts, and the bottom resistor to ground. The voltage at the middle will be proportional to the bottom resistor relative to the total resistance (top resistor + bottom resistor). When one of the resistors changes (as it will when your sensor senses things), the output voltage will change as well!

Although the sensor’s resistance will vary, the resistive sensors (flex sensor light sensor, softpot, and trimpot) in the SIK are around 10K ohms. We usually want the fixed resistor to be close to this value, so using a 10K resistor is a great choice for the fixed “bottom” resistor. Please note the fixed resistor isn’t necessarily the bottom resistor. We do that with the photodiode only so that more light = more voltage, but it could be flipped and we’d get the opposite response.
A street lamp uses a light sensor to detect when to turn the lights on at night.

**Circuit 2**

**Arduino Code:**

```c
lightLevel = map(lightLevel, 0, 1023, 0, 255);
```

**Parameters**

- `value`: the number to map
- `fromLow`: the lower bound of the value’s current range
- `fromHigh`: the upper bound of the value’s current range
- `toLow`: the lower bound of the value’s target range
- `toHigh`: the upper bound of the value’s target range

When we read an analog signal using `analogRead()`, it will be a number from 0 to 1023. But when we want to drive a PWM pin using `analogWrite()`, it wants a number from 0 to 255. We can “squeeze” the larger range into the smaller range using the `map()` function.


```c
lightLevel = constrain(lightLevel, 0, 255);
```

**Parameters**

- `x`: the number to constrain, all data types
- `a`: the lower end of the range, all data types
- `b`: the upper end of the range, all data types

Because `map()` could still return numbers outside the “to” range, we’ll also use a function called `constrain()` that will “clip” numbers into a range. If the number is outside the range, it will make it the largest or smallest number. If it is within the range, it will stay the same.


**What You Should See:**

You should see the LED grow brighter or dimmer in accordance with how much light your photoresistor is reading. If it isn’t working, make sure you have assembled the circuit correctly and verified and uploaded the code to your board or see the troubleshooting tips below.

**Troubleshooting:**

**LED Remains Dark**

This is a mistake we continue to make time and time again, if only they could make an LED that worked both ways. Pull it up and give it a twist.

**It Isn’t Responding to Changes in Light**

Given that the spacing of the wires on the photo-resistor is not standard, it is easy to misplace it. Double check it’s in the right place.

**Still Not Quite Working**

You may be in a room which is either too bright or dark. Try turning the lights on or off to see if this helps. Or if you have a flashlight near by give that a try.

**Real World Application:**

A street lamp uses a light sensor to detect when to turn the lights on at night.
A temperature sensor is exactly what it sounds like – a sensor used to measure ambient temperature. This particular sensor has three pins – a positive, a ground, and a signal. This is a linear temperature sensor. A change in temperature of one degree centigrade is equal to a change of 10 millivolts at the sensor output. The TMP36 sensor has a nominal 750 mV at 25°C (about room temperature). In this circuit, you’ll learn how to integrate the temperature sensor with your RedBoard, and use the Arduino IDE’s serial monitor to display the temperature.

When you’re building the circuit be careful not to mix up the transistor and the temperature sensor, they’re almost identical. Look for “TMP” on the body of the temperature sensor.
Circuit 7: Temperature Sensor
This circuit uses the Arduino IDE’s **serial monitor**. To open this, first upload the program then click the button which looks like a magnifying glass in a square. In order for the serial monitor to operate correctly it must be set to the same baud rate (speed in bits per second) as the code you’re running. This code runs at 9600 baud; if the baud rate setting is not 9600, change it to 9600.
Building climate control systems use a temperature sensor to monitor and maintain their settings.  

Arduino Code: 

Open Arduino IDE // File > Examples > SIK Guide > Circuit # 7

Code to Note:

Serial.begin(9600);

Before using the serial monitor, you must call Serial.begin() to initialize it. 9600 is the "baud rate", or communications speed. When two devices are communicating with each other, both must be set to the same speed.

Serial.print(degreesC);

The Serial.print() command is very smart. It can print out almost anything you can throw at it, including variables of all types, quoted text (AKA "strings"), etc. See http://arduino.cc/en/serial/print for more info.

Serial.println(degreesF);

Serial.println() will print everything on the same line. Serial.println() will move to the next line. By using both of these commands together, you can create easy-to-read printouts of text and data.

What You Should See:

You should be able to read the temperature your temperature sensor is detecting on the serial monitor in the Arduino IDE. If it isn’t working, make sure you have assembled the circuit correctly and verified and uploaded the code to your board or see the troubleshooting tips below.

Troubleshooting:

Nothing Seems to Happen
This program has no outward indication it is working. To see the results you must open the Arduino IDE’s serial monitor (instructions on previous page).

Gibberish is Displayed
This happens because the serial monitor is receiving data at a different speed than expected. To fix this, click the pull-down box that reads "*** baud" and change it to "9600 baud".

Temperature Value is Unchanging
Try pinching the sensor with your fingers to heat it up or pressing a bag of ice against it to cool it down.

Real World Application:

Building climate control systems use a temperature sensor to monitor and maintain their settings.
Circuit #8

A Single Servo

Servos are ideal for embedded electronics applications because they do one thing very well that motors cannot – they can move to a position accurately. By varying the pulse width of the output voltage to a servo, you can move a servo to a specific position. For example, a pulse of 1.5 milliseconds will move the servo 90 degrees. In this circuit, you’ll learn how to use PWM (pulse width modulation) to control and rotate a servo.
Circuit 8: A Single Servo
The Arduino development environment gives you a very useful set of built-in commands for doing basic input and output, making decisions using logic, solving math problems, etc. But the real power of Arduino is the huge community using it and their willingness to share their work.

Libraries are collections of new commands that have been packaged together to make it easy to include them in your sketches. Arduino comes with a handful of useful libraries, such as the servo library used in this example, that can be used to interface to more advanced devices (LCD displays, stepper motors, ethernet ports, etc.)


But anyone can create a library, and if you want to use a new sensor or output device, chances are that someone out there has already written one that interfaces that device to the RedBoard. Many of SparkFun’s products come with Arduino libraries, and you can find even more using Google and the Arduino Playground at [http://arduino.cc/playground/](http://arduino.cc/playground/). When YOU get the RedBoard working with a new device, consider making a library for it and sharing it with the world!

To use a library in a sketch, select it from **Sketch > Import Library**.

After importing the library into your code, you will have access to a number of pre-written commands and functions. More information on how to use the standard library functions can be accessed at: [http://arduino.cc/en/Reference/Libraries](http://arduino.cc/en/Reference/Libraries).
#include is a special “preprocessor” command that inserts a library (or any other file) into your sketch. You can type this command yourself, or choose an installed library from the “sketch / import library” menu.

```cpp
#include <Servo.h>
```

The servo library adds new commands that let you control a servo. To prepare the Arduino to control a servo, you must first create a Servo “object” for each servo (here we’ve named it “servo1”), and then “attach” it to a digital pin (here we’re using pin 9).

```cpp
Servo servo1;
servo1.attach(9);
```

The servos in this kit don’t spin all the way around, but they can be commanded to move to a specific position. We use the servo library’s write() command to move a servo to a specified number of degrees (0 to 180). Remember that the servo requires time to move, so give it a short delay() if necessary.

```cpp
servo1.write(180);
```

You should see your servo motor move to various locations at several speeds. If the motor doesn’t move, check your connections and make sure you have verified and uploaded the code, or see the troubleshooting tips below.

## Troubleshooting:

**Servo Not Twisting**
Even with colored wires it is still shockingly easy to plug a servo in backward. This might be the case.

**Still Not Working**
A mistake we made a time or two was simply forgetting to connect the power (red and brown wires) to +5 volts and ground.

**Fits and Starts**
If the servo begins moving then twitches, and there’s a flashing light on your RedBoard, the power supply you are using is not quite up to the challenge. Using a wall adapter instead of USB should solve this problem.

## Real World Application:

Robotic arms you might see in an assembly line or sci-fi movie probably have servos in them.
Flex Sensor

In this circuit, we will use a flex sensor to measure, well, flex! A flex sensor uses carbon on a strip of plastic to act like a variable resistor, but instead of changing the resistance by turning a knob, you change it by flexing (bending) the component. We use a “voltage divider” again to detect this change in resistance. The sensor bends in one direction and the more it bends, the higher the resistance gets; it has a range from about 10K ohm to 35K ohm. In this circuit we will use the amount of bend of the flex sensor to control the position of a servo.
Circuit 9: Flex Sensor
It happens to everyone - you write a sketch which successfully compiles and uploads, but you can't figure out why it's not doing what you want it to. Larger computers have screens, keyboards, and mice that you can use to debug your code, but tiny computers like the RedBoard have no such things.

The key to visibility into a microcontroller is output. This can be almost anything, including LEDs and buzzers, but one of the most useful tools is the serial monitor. Using `Serial.print()` and `println()`, you can easily output human-readable text and data from the RedBoard to a window back on the host computer. This is great for your sketch's final output, but it's also incredibly useful for debugging.

Debugging your sketches using the Serial Monitor:

It happens to everyone - you write a sketch which successfully compiles and uploads, but you can't figure out why it's not doing what you want it to. Larger computers have screens, keyboards, and mice that you can use to debug your code, but tiny computers like the RedBoard have no such things.

The key to visibility into a microcontroller is output. This can be almost anything, including LEDs and buzzers, but one of the most useful tools is the serial monitor. Using `Serial.print()` and `println()`, you can easily output human-readable text and data from the RedBoard to a window back on the host computer. This is great for your sketch's final output, but it's also incredibly useful for debugging.

You wanted 1 to 8, but the loop is actually giving you 0 to 7. Whoops! Now you just need to fix the loop.

And if you run the code again, you'll see the output you wanted:
Controller accessories for video game consoles like Nintendo’s “Power Glove” use flex-sensing technology. It was the first video game controller attempting to mimic hand movement on a screen in real time.

Arduino Code:

```
Circuit 2
Servo Not Twisting
Servo Not Moving as Expected
Servo Doesn’t Move very Far

What You Should See:

You should see the servo motor move in accordance with how much you are flexing the flex sensor. If it isn’t working, make sure you have assembled the circuit correctly and verified and uploaded the code to your board or see the troubleshooting tips below.

Troubleshooting:

Servo Not Twisting
Even with colored wires it is still shockingly easy to plug a servo in backwards. This might be the case.

Servo Not Moving as Expected
The sensor is only designed to work in one direction. Try flexing it the other way (where the striped side faces out on a convex curve).

Servo Doesn’t Move very Far
You need to modify the range of values in the call to the map() function.

Real World Application:

Controller accessories for video game consoles like Nintendo’s “Power Glove” use flex-sensing technology. It was the first video game controller attempting to mimic hand movement on a screen in real time.

servoposition = map(flexposition, 600, 900, 0, 180);
map(value, fromLow, fromHigh, toLow, toHigh)

Because the flex sensor / resistor combination won’t give us a full 0 to 5 volt range, we’re using the map() function as a handy way to reduce that range. Here we’ve told it to only expect values from 600 to 900, rather than 0 to 1023.

servoposition = constrain(servoposition, 0, 180);
constrain(x, a, b)

Because map() could still return numbers outside the "to" range, we’ll also use a function called constrain() that will "clip" numbers into a range. If the number is outside the range, it will make it the largest or smallest number. If it is within the range, it will stay the same.

What You Should See:

You should see the servo motor move in accordance with how much you are flexing the flex sensor. If it isn’t working, make sure you have assembled the circuit correctly and verified and uploaded the code to your board or see the troubleshooting tips below.

Troubleshooting:

Servo Not Twisting
Even with colored wires it is still shockingly easy to plug a servo in backwards. This might be the case.

Servo Not Moving as Expected
The sensor is only designed to work in one direction. Try flexing it the other way (where the striped side faces out on a convex curve).

Servo Doesn’t Move very Far
You need to modify the range of values in the call to the map() function.

Real World Application:

Controller accessories for video game consoles like Nintendo’s “Power Glove” use flex-sensing technology. It was the first video game controller attempting to mimic hand movement on a screen in real time.

servoposition = map(flexposition, 600, 900, 0, 180);
map(value, fromLow, fromHigh, toLow, toHigh)

Because the flex sensor / resistor combination won’t give us a full 0 to 5 volt range, we’re using the map() function as a handy way to reduce that range. Here we’ve told it to only expect values from 600 to 900, rather than 0 to 1023.

servoposition = constrain(servoposition, 0, 180);
constrain(x, a, b)

Because map() could still return numbers outside the "to" range, we’ll also use a function called constrain() that will "clip" numbers into a range. If the number is outside the range, it will make it the largest or smallest number. If it is within the range, it will stay the same.

What You Should See:

You should see the servo motor move in accordance with how much you are flexing the flex sensor. If it isn’t working, make sure you have assembled the circuit correctly and verified and uploaded the code to your board or see the troubleshooting tips below.

Troubleshooting:

Servo Not Twisting
Even with colored wires it is still shockingly easy to plug a servo in backwards. This might be the case.

Servo Not Moving as Expected
The sensor is only designed to work in one direction. Try flexing it the other way (where the striped side faces out on a convex curve).

Servo Doesn’t Move very Far
You need to modify the range of values in the call to the map() function.

Real World Application:

Controller accessories for video game consoles like Nintendo’s “Power Glove” use flex-sensing technology. It was the first video game controller attempting to mimic hand movement on a screen in real time.

servoposition = map(flexposition, 600, 900, 0, 180);
map(value, fromLow, fromHigh, toLow, toHigh)

Because the flex sensor / resistor combination won’t give us a full 0 to 5 volt range, we’re using the map() function as a handy way to reduce that range. Here we’ve told it to only expect values from 600 to 900, rather than 0 to 1023.
In this circuit, we are going to use yet another kind of variable resistor – this time, a soft potentiometer (or soft pot). This is a thin and flexible strip that can detect where pressure is being applied. By pressing down on various parts of the strip, you can vary the resistance from 100 to 10K ohms. You can use this ability to track movement on the soft pot, or simply as a button. In this circuit, we’ll get the soft pot up and running to control an RGB LED.
Circuit 10: Soft Potentiometer
### Components

<table>
<thead>
<tr>
<th>Component</th>
<th>Image Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jumper Wire</td>
<td><img src="image" alt="Jumper Wire" /></td>
</tr>
<tr>
<td>Jumper Wire</td>
<td><img src="image" alt="Jumper Wire" /></td>
</tr>
<tr>
<td><strong>RGB LED (5mm)</strong></td>
<td><img src="image" alt="RGB LED (5mm)" /></td>
</tr>
<tr>
<td><strong>Soft Potentiometer</strong></td>
<td><img src="image" alt="Soft Potentiometer" /></td>
</tr>
<tr>
<td>330Ω Resistor</td>
<td><img src="image" alt="330Ω Resistor" /></td>
</tr>
<tr>
<td>330Ω Resistor</td>
<td><img src="image" alt="330Ω Resistor" /></td>
</tr>
<tr>
<td>10KΩ Resistor</td>
<td><img src="image" alt="10KΩ Resistor" /></td>
</tr>
<tr>
<td>Jumper Wire</td>
<td><img src="image" alt="Jumper Wire" /></td>
</tr>
<tr>
<td>Jumper Wire</td>
<td><img src="image" alt="Jumper Wire" /></td>
</tr>
<tr>
<td>Jumper Wire</td>
<td><img src="image" alt="Jumper Wire" /></td>
</tr>
<tr>
<td>Jumper Wire</td>
<td><img src="image" alt="Jumper Wire" /></td>
</tr>
<tr>
<td>Jumper Wire</td>
<td><img src="image" alt="Jumper Wire" /></td>
</tr>
<tr>
<td>Jumper Wire</td>
<td><img src="image" alt="Jumper Wire" /></td>
</tr>
</tbody>
</table>

### Connections

- **5V**
- **GND**

---

**Note:** The diagram shows connections and components used in a circuit diagram. Each component is connected via jumper wires as indicated by the diagram.
The knobs found on many objects, like a radio for instance, are using similar concepts to the one you just completed for this circuit.

Circuit 2

Arduino Code:

```cpp
redValue = constrain(map(RGBposition, 0, 341, 255, 0, 255)
    + constrain(map(RGBposition, 682, 1023, 0, 255), 0, 255);

greenValue = constrain(map(RGBposition, 0, 341, 0, 255)
    - constrain(map(RGBposition, 341, 682, 0, 255), 0, 255);

blueValue = constrain(map(RGBposition, 341, 682, 0, 255)
    - constrain(map(RGBposition, 682, 1023, 0, 255), 0, 255);
```

Troubleshooting:

- **LED Remains Dark or Shows Incorrect Color**
  With the four pins of the LED so close together, it’s sometimes easy to misplace one. Try double checking each pin is where it should be.

- **Bizarre Results**
  The most likely cause of this is if you’re pressing the potentiometer in more than one position. This is normal and can actually be used to create some neat results.

What You Should See:

You should see the RGB LED change colors in accordance with how you interact with the soft potentiometer. If it isn’t working, make sure you have assembled the circuit correctly and verified and uploaded the code to your board, or see the troubleshooting tips below.

Real World Application:

The knobs found on many objects, like a radio for instance, are using similar concepts to the one you just completed for this circuit.
In this circuit, we'll again bridge the gap between the digital world and the analog world. We'll be using a buzzer that makes a small "click" when you apply voltage to it (try it!). By itself that isn't terribly exciting, but if you turn the voltage on and off hundreds of times a second, the buzzer will produce a tone. And if you string a bunch of tones together, you've got music! This circuit and sketch will play a classic tune. We'll never let you down!

**PARTS:**
- Piezo Element: x1
- Wire: x3

If the buzzer doesn’t easily fit into the holes on the breadboard, try rotating it slightly.
Circuit 11: Piezo Elements
### Creating your own functions:

Arduino contains a wealth of built-in functions that are useful for all kinds of things. (See [http://arduino.cc/en/reference](http://arduino.cc/en/reference) for a list). But you can also easily create your own functions. First, we need to declare a function. Here's a simple example named “add,” which adds two numbers together and returns the result. Let’s break it down.

```c
int add(int parameter1, int parameter2)
{
    int x;
    x = parameter1 + parameter2;
    return(x);
}
```

Your functions can take in values ("parameters"), and return a value, as this one does.

If you’ll be passing parameters to your function, put them (and their types) in the parentheses after the function name. If your function is not using any parameters, just use an empty parenthesis () after the name.

If your function is returning a value from your function, put the type of the return value in front of the function name. Then in your function, when you’re ready to return the value, put in a return(value) statement. If you won’t be returning a value, put "void" in front of the function name (similar to the declaration for the setup() and loop() functions).

Many modern megaphones have settings that use a loud amplified buzzer. They are usually very loud and quite good at getting people’s attention.

Arduino Code:

```c
char notes[] = "cdʃda ag cdʃdg gf ";
char names[] = {'c','d','e','f','g','a','b','C'};

tone(pin, frequency, duration);
```

Up until now we’ve been working solely with numerical data, but the Arduino can also work with text. Characters (single, printable, letters, numbers and other symbols) have their own type, called “char”. When you have an array of characters, it can be defined between double-quotes (also called a “string”), OR as a list of single-quoted characters.

One of Arduino’s many useful built-in commands is the tone() function. This function drives an output pin at a certain frequency, making it perfect for driving buzzers and speakers. If you give it a duration (in milliseconds), it will play the tone then stop. If you don’t give it a duration, it will keep playing the tone forever (but you can stop it with another function, noTone() ).

What You Should See:

You should see - well, nothing! But you should be able to hear a song. If it isn’t working, make sure you have assembled the circuit correctly and verified and uploaded the code to your board or see the troubleshooting tips below.

Troubleshooting:

- **No Sound**
  Given the size and shape of the piezo element it is easy to miss the right holes on the breadboard. Try double checking its placement.

- **Can’t Think While the Melody is Playing**
  Just pull up the piezo element whilst you think, upload your program then plug it back in.

- **Feeling Let Down and Deserted**
  The code is written so you can easily add your own songs.

Real World Application:

Many modern megaphones have settings that use a loud amplified buzzer. They are usually very loud and quite good at getting people’s attention.
CIRCUIT #12

Spinning a Motor

Remember before when you played around with a servo motor? Now we are going to tackle spinning a motor. This requires the use of a transistor, which can switch a larger amount of current than the RedBoard can. When using a transistor, you just need to make sure its maximum specs are high enough for your use. The transistor we are using for this circuit is rated at 40V max and 200 milliamps max – perfect for our toy motor!

When the motor is spinning and suddenly turned off, the magnetic field inside it collapses, generating a voltage spike. This can damage the transistor. To prevent this, we use a “flyback diode”, which diverts the voltage spike around the transistor.

When you’re building the circuit be careful not to mix up the transistor and the temperature sensor, they’re almost identical. Look for “P2N2222A” on the body of the transistor.

PARTS:

- Transistor: P2N2222A x1
- Diode: 1N4148 x1
- DC Motor x1
- Wire x6
- Resistor (330 ohm) x1
- RedBoard
- Resistor (330 ohm) (Orange-Orange-Brown)
- Transistor (P2N2222AG)
- DC Motor
- Diode (1N4148)
- GND (Ground)
- 5 volt
Circuit 12: Spinning a Motor
At this point you’re probably starting to get your own ideas for circuits that do fun things, or help solve a real problem. Excellent! Here are some tips on programming in general.

Most of the sketches you write will be a loop with some or all of these steps:

1. **Perform some sort of input**
2. **Make some calculations or decisions**
3. **Perform some sort of output**
4. **Repeat! (Or not!)**

We’ve already shown you how to use a bunch of different input sensors and output devices (and we still have a few more to go). Feel free to make use of the examples in your own sketches - this is the whole idea behind the “Open Source” movement.

It’s usually pretty easy to pull pieces of different sketches together, just open them in two windows, and copy and paste between them. This is one of the reasons we’ve been promoting “good programming habits”. Things like using constants for pin numbers, and breaking your sketch into functions, make it much easier to re-use your code in new sketches. For example, if you pull in two pieces of code that use the same pin, you can easily change one of the constants to a new pin. (Don’t forget that not all of the pins support `analogWrite()`; the compatible pins are marked on your board.)

If you need help, there are internet forums where you can ask questions. Try Arduino’s forum at [arduino.cc/forum](http://arduino.cc/forum), and SparkFun’s at [forum.sparkfun.com](http://forum.sparkfun.com). When you’re ready to move to more advanced topics, take a look at Arduino’s tutorials page at [arduino.cc/en/tutorial](http://arduino.cc/en/tutorial). Many of SparkFun’s more advanced products were programmed with Arduino, (allowing you to easily modify them), or have Arduino examples for them. See our product pages for info.

Finally, when you create something really cool, consider sharing it with the world so that others can learn from your genius. Be sure to let us know on [https://www.sparkfun.com/project_calls](https://www.sparkfun.com/project_calls) so we can put it on our home page!
12

Open Arduino IDE // File > Examples > SIK Guide > Circuit # 12

Arduino Code:

```cpp
while (Serial.available() > 0) {
  speed = Serial.parseInt();
}
```

The RedBoard’s serial port can be used to receive as well as send data. Because data could arrive at any time, the RedBoard stores, or "buffers" data coming into the port until you’re ready to use it. The `Serial.available()` command returns the number of characters that the port has received, but haven’t been used by your sketch yet. Zero means no data has arrived.

If the port has data waiting for you, there are a number of ways for you to use it. Since we’re typing numbers into the port, we can use the handy `Serial.parseInt()` command to extract, or “parse” integer numbers from the characters it’s received. If you type “1” “0” “0” to the port, this function will return the number 100.

What You Should See:

The DC Motor should spin if you have assembled the circuit’s components correctly, and also verified/uploaded the correct code. If your circuit is not working check the troubleshooting section below.

Troubleshooting:

**Motor Not Spinning**
If you sourced your own transistor, double check with the data sheet that the pinout is compatible with a P2N2222AG (many are reversed).

**Still No Luck**
If you sourced your own motor, double check that it will work with 5 volts and that it does not draw too much power.

**Still Not Working**
Sometimes the RedBoard will disconnect from the computer. Try un-plugging and then re-plugging it into your USB port.

Real World Application:

Radio Controlled(RC) cars use Direct Current(DC) motors to turn the wheels for propulsion.
In this circuit, we are going to use some of the lessons we learned in circuit 12 to control a relay. A relay is basically an electrically controlled mechanical switch. Inside that harmless looking plastic box is an electromagnet that, when it gets a jolt of energy, causes a switch to trip. In this circuit, you’ll learn how to control a relay like a pro – giving your RedBoard even more powerful abilities!

When the relay is off, the COM (common) pin will be connected to the NC (Normally Closed) pin. When the relay is on, the COM (common) pin will be connected to the NO (Normally Open) pin.
Circuit 13: Relays
### Component: Jumper Wire

- Component: LED (5mm)
- Component: 5V
- Component: 330 ohm Resistor

### Component: Relay

- Component: P2N2222A

### Component: Diode

- Component: 1N4148

### Component: Transistor

- Component: P2N2222AG

---

**Pin 2**

- Pin 2

---

**Image Reference:**

- Image Reference: Jumper Wire
- Image Reference: Jumper Wire
- Image Reference: Jumper Wire
- Image Reference: Jumper Wire
- Image Reference: Jumper Wire
- Image Reference: Jumper Wire
- Image Reference: Jumper Wire
- Image Reference: GND
- Image Reference: 5V

---

**Component:**

- Relay
- Diode 1N4148
- Transistor P2N2222AG
- LED (5mm)
- 5V
- 330 ohm Resistor
- Jumper Wire
**Arduino Code:**

`digitalWrite(relayPin, HIGH);`

When we turn on the transistor, which in turn energizes the relay’s coil, the relay’s switch contacts are closed. This connects the relay’s COM pin to the NO (Normally Open) pin. Whatever you’ve connected using these pins will turn on. (Here we’re using LEDs, but this could be almost anything.)

`digitalWrite(relayPin, LOW);`

The relay has an additional contact called NC (Normally Closed). The NC pin is connected to the COM pin when the relay is OFF. You can use either pin depending on whether something should be normally on or normally off. You can also use both pins to alternate power to two devices, much like railroad crossing warning lights.

**What You Should See:**

You should be able to hear the relay contacts click, and see the two LEDs alternate illuminating at 1-second intervals. If you don’t, double-check that you have assembled the circuit correctly, and uploaded the correct sketch to the board. Also, see the troubleshooting tips below.

**Troubleshooting:**

- **LEDs Not Lighting**
  Double-check that you’ve plugged them in correctly. The longer lead (and non-flat edge of the plastic flange) is the positive lead.

- **No Clicking Sound**
  The transistor or coil portion of the circuit isn’t quite working. Check the transistor is plugged in the right way.

- **Not Quite Working**
  The included relays are designed to be soldered rather than used in a breadboard. As such you may need to press it in to ensure it works (and it may pop out occasionally). When you’re building the circuit be careful not to mix up the temperature sensor and the transistor, they’re almost identical.

**Real World Application:**

Garage door openers use relays to operate. You might be able to hear the clicking if you listen closely.
Now we are going to step into the world of ICs (integrated circuits). In this circuit, you’ll learn all about using a shift register (also called a serial-to-parallel converter). The shift register will give your RedBoard an additional eight outputs, using only three pins on your board. For this circuit, you’ll practice by using the shift register to control eight LEDs.
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Image Reference:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Component:</td>
<td>IC</td>
<td>LED (5mm)</td>
<td>LED (5mm)</td>
<td>LED (5mm)</td>
<td>LED (5mm)</td>
<td>LED (5mm)</td>
<td>LED (5mm)</td>
<td>LED (5mm)</td>
<td>LED (5mm)</td>
<td>LED (5mm)</td>
<td>LED (5mm)</td>
<td>LED (5mm)</td>
<td>LED (5mm)</td>
<td>LED (5mm)</td>
<td>LED (5mm)</td>
<td>LED (5mm)</td>
</tr>
<tr>
<td>Image Reference:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Similar to circuit #4, a scrolling marquee display delivers a message with multiple LEDs. Essentially the same task the shift register achieves here in Circuit #14.

Arduino Code:

```cpp
shiftOut(datapin, clockpin, MSBFIRST, data);
```

You’ll communicate with the shift register (and a lot of other parts) using an interface called SPI, or Serial Peripheral Interface. This interface uses a data line and a separate clock line that work together to move data in or out of the RedBoard at high speed. The MSBFIRST parameter specifies the order in which to send the individual bits, in this case we’re sending the Most Significant Bit first.

```cpp
bitWrite(data, desiredPin, desiredState);
```

Bits are the smallest possible piece of memory in a computer; each one can store either a “1” or a “0”. Larger numbers are stored as arrays of bits. Sometimes we want to manipulate these bits directly, for example now when we’re sending eight bits to the shift register and we want to make them 1 or 0 to turn the LEDs on or off. The RedBoard has several commands, such as `bitWrite()`, that make this easy to do.

What You Should See:

You should see the LEDs light up similarly to circuit 4 (but this time, you’re using a shift register). If they aren’t, make sure you have assembled the circuit correctly and verified and uploaded the code to your board. See the troubleshooting tips below.

Troubleshooting:

The RedBoard’s power LED goes out
This happened to us a couple of times, it happens when the chip is inserted backward. If you fix it quickly nothing will break.

Not Quite Working
Sorry to sound like a broken record but it is probably something as simple as a crossed wire.

Frustration
Shoot us an e-mail, this circuit is both simple and complex at the same time. We want to hear about problems you have so we can address them in future editions: techsupport@sparkfun.com

Real World Application:

Similar to circuit #4, a scrolling marquee display delivers a message with multiple LEDs. Essentially the same task the shift register achieves here in Circuit #14.
In this circuit, you’ll learn about how to use an LCD. An LCD, or liquid crystal display, is a simple screen that can display commands, bits of information, or readings from your sensor - all depending on how you program your board. In this circuit, you’ll learn the basics of incorporating an LCD into your project.
<table>
<thead>
<tr>
<th>Component:</th>
<th>Image Reference:</th>
<th>Component:</th>
<th>Image Reference:</th>
</tr>
</thead>
<tbody>
<tr>
<td>LCD</td>
<td>![LCD Image]</td>
<td>Jumper Wire</td>
<td>![Jumper Wire Image]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Pin 3</td>
<td>f18</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Pin 4</td>
<td>f19</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Pin 5</td>
<td>f20</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Pin 11</td>
<td>f25</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Pin 12</td>
<td>f27</td>
</tr>
<tr>
<td>Potentiometer</td>
<td>![Potentiometer Image]</td>
<td>Jumper Wire</td>
<td>![Jumper Wire Image]</td>
</tr>
<tr>
<td>Jumper Wire</td>
<td>![Jumper Wire Image]</td>
<td>Pin 2</td>
<td>f17</td>
</tr>
<tr>
<td>Jumper Wire</td>
<td>![Jumper Wire Image]</td>
<td>Pin 3</td>
<td>f18</td>
</tr>
<tr>
<td>Jumper Wire</td>
<td>![Jumper Wire Image]</td>
<td>Pin 4</td>
<td>f19</td>
</tr>
<tr>
<td>Jumper Wire</td>
<td>![Jumper Wire Image]</td>
<td>Pin 5</td>
<td>f20</td>
</tr>
<tr>
<td>Jumper Wire</td>
<td>![Jumper Wire Image]</td>
<td>Pin 11</td>
<td>f25</td>
</tr>
<tr>
<td>Jumper Wire</td>
<td>![Jumper Wire Image]</td>
<td>Pin 12</td>
<td>f27</td>
</tr>
<tr>
<td>Jumper Wire</td>
<td>![Jumper Wire Image]</td>
<td>Pin 2</td>
<td>f17</td>
</tr>
</tbody>
</table>

Legend:
- **LCD**
- **Jumper Wire**
- **Pin**
- **GND**
- **5V**
#include <LiquidCrystal.h>

This bit of code tells your Arduino IDE to include the library for a simple LCD display. Without it, none of the commands will work, so make sure you include it!

lcd.print("hello, world!");

This is the first time you’ll fire something up on your screen. You may need to adjust the contrast to make it visible. Twist the potentiometer until you can clearly see the text!

**What you Should See:**

Initially, you should see the words "hello, world!" pop up on your LCD. Remember you can adjust the contrast using the potentiometer if you can’t make out the words clearly. If you have any issues, make sure your code is correct and double-check your connections.

**Troubleshooting:**

**The Screen is Blank or Completely Lit?**
Fiddle with the contrast by twisting the potentiometer. If it’s incorrectly adjusted, you won’t be able to read the text.

**Not Working At All?**
Double check the code, specifically that you include the LCD library.

**Screen Is Flickering**
Double check your connections to your breadboard and Arduino.

**Real World Application:**

LCDs are everywhere! From advanced LCDs like your television, to simple notification screens, this is a very common and useful display!
Visit us Online:

This is just the beginning of your exploration into embedded electronics and coding. Our website has a wealth of tutorials to whet your appetite for more knowledge. We also host a community of hackers, engineers, DIYers, etc. in our forums. So log on to our website for more information about Arduino, or to plan ahead for your next project!

sparkfun.com
Begin your Journey into Electronics

This kit will guide you through experiments of varying difficulty as you learn all about embedded systems, physical computing, programming and more! This kit is perfect for anyone who wants to explore the power of the RedBoard platform.

The SparkFun Inventor’s Kit teaches basic programming, for which you will need both a computer and an internet connection.

You will also learn to assemble 15 basic physical electronic circuits, but no soldering is required. No previous experience is necessary!

KIT INCLUDES

- SparkFun RedBoard
- Breadboard
- Instruction booklet
- Sealed relay
- Small servo
- Yellow and red LEDs
- RGB LED
- Temperature sensor
- DC motor
- 8-bit shift register
- Push button switches
- Potentiometer
- Photoresistor
- Transistors
- Jumper wires
- USB cable
- Signal diodes
- 10k ohm resistors
- 330 ohm resistors
- Piezo buzzer
- Flex sensor
- Soft potentiometer
- Baseplate
- LCD

© SparkFun Electronics, Inc. All rights reserved. The SparkFun Inventor’s Kit for the SparkFun RedBoard features, specifications, system requirements and availability are subject to change without notice. All other trademarks contained herein are the property of their respective owners.

To view a copy of this license visit: http://creativecommons.org/by-sa/3.0/
Or write: Creative Commons, 171 Second Street, Suite 200, San Francisco, CA 94105, USA.